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PREÁMBULO 

 

 Esta guía ha sido elaborada como material didáctico práctico del curso virtual “Modelamiento 

Hidrológico con HEC-HMS y HEC-GeoHMS: pronóstico de crecidas” (60h), organizado por el Grupo 

de Gestión y Apoyo a la Ingeniería Agrícola de Colombia (GAIACOL) y el Grupo de Hidráulica e 

Hidrología de la Universidad de Valladolid – España. 
 

 El software HEC-HMS 3.5 y HEC Geo-HMS junto con sus respectivos manuales oficiales en idioma 

inglés (usuario, técnico, y aplicaciones) están disponibles en la web del U.S. Army Corps of 

Engineers: http://www.hec.usace.army.mil/software/hec-hms/download.html 
 

 Se ruega al lector benevolencia. Sus sugerencias serán bienvenidas para próximas ediciones. 

 

 

1. INTRODUCCIÓN 

1.1. Software HEC-HMS 3.5 

El programa Hydrologic Modeling System HEC-HMS 3.5 ha sido desarrollado por el Hydrologic 

Engineering Center del U.S. Corps of Engineers (HEC, 2010) para simular procesos de transformación 

lluvia-escorrentía en sistemas de cuencas dendríticas. Reúne una colección de modelos hidrológicos 

determinísticos de tipo evento/continuo, agregado/distribuido, y empírico/conceptual combinables 

para generar los hidrogramas de una cuenca en respuesta a lluvias de cálculo reales o sintéticas. El 

componente específico para la calibración de los diferentes métodos facilita la aplicación responsable 

de HEC-HMS 3.5 en los análisis típicos de crecidas en cuencas con escorrentía natural o en zonas 

urbanas, así como en los estudios de disponibilidad hídrica en grandes cuencas.  

 

Los hidrogramas generados por el programa pueden ser utilizados directamente o junto con otros 

programas (GIS, Autocad, etc) con finalidades diversas en el ámbito técnico-científico tales como: 

 

 Regulación de actividades en zonas inundables dentro del ordenamiento territorial. 

 Pronóstico de crecidas y reducción de daños por inundación. 

 Operación de infraestructuras hidráulicas actuales de transporte y almacenamiento. 

 Planificación y diseño de nuevos proyectos hidráulicos. 

 Disponibilidad hídrica: índice de escasez en Colombia. 

 Impacto de cambios de uso del suelo: urbanización, deforestación, conservación de suelos, etc. 

 Efecto de un eventual cambio del clima en los eventos hidrológicos extremos. 

 Hidrología de zonas húmedas. 

 Drenaje urbano. 

 Investigación: adaptación a las condiciones locales de modelos de infiltración (NC), parámetros de 

generación de hidrogramas (tiempos de concentración y desfase), modelos de lluvia, etc.  

 

La versión 3.5 de HEC-HMS es la informatización más reciente y ampliada del primitivo HEC-1 (1968) 

en entorno DOS. Su programación combina los lenguajes C, C++, y Fortran. HEC-HMS 3.5 es un 

software de dominio público.  
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1.2. Modelo hidrológico 

Los modelos hidrológicos que agrupa HEC-HMS 3.5 son representaciones matemáticas que simplifican 

los procesos reales en una cuenca, y que pueden substituirlos en determinadas condiciones y para 

finalidades concretas. Existen dos tipos de relaciones entre las variables conocidas (entrada) y las 

variables desconocidas (salida) con las que puede conformarse un modelo hidrológico con HEC-HMS: 

 

1. Precipitación (entrada)  Hidrograma (salida). 

2. Hidrograma aguas arriba (entrada)  Hidrograma aguas abajo (salida). 

 

Todos los modelos disponibles constan de los siguientes componentes:  

 

 Variable(s) de estado: definen la condición del sistema hidrológico en un momento y lugar 

determinados. Por ejemplo, en el modelo de tránsito de hidrograma en embalse (Puls) describen su 

estado en términos de cota de agua, volumen almacenado, salidas por elementos de desagüe, etc.  

 Parámetro(s): medidas numéricas de las propiedades del sistema real. Controlan las funciones 

matemáticas entre las entradas y las salidas de cada modelo. Pueden tener una significación física 

obvia (pendiente del río en el modelo Muskingum-Cunge de tránsito en cauce), o ser puramente 

empíricos (coeficiente de pico en el hidrograma de Snyder´s). En cualquier caso, los parámetros de 

un modelo pueden ser ajustados durante su calibración, de modo que los pronósticos representen 

de modo confiable la respuesta real del evento en la cuenca. 

 Condición(es) de contorno: valores de las entradas del sistema hidrológico y que causan su cambio. 

La más frecuente es la precipitación, la cual genera una escorrentía. Otro caso es el hidrograma de 

entrada en un modelo de tránsito en cauce. 

 Condición(es) incial(es): describen el estado del sistema al inicio del evento, a partir del cual se 

resuelven las ecuaciones de los diferentes modelos. El caudal circulante representa la condición 

inicial en los modelos de escorrentía al comienzo de la tormenta, y también en los modelos de 

tránsito en cauces en el momento de la entrada.  

 

El carácter determinístico de todos los modelos de HEC-HMS requiere el conocimiento exacto de los 

parámetros, las condiciones de contorno, y las condiciones iniciales.  

 

1.3. Componentes del Modelo HEC-HMS 

Para simular la respuesta hidrológica de una cuenca a una entrada de lluvia y/o caudal HEC-HMS 

integra los siguientes 4 componentes: 1) modelo de cuenca (“basin model”); 2) modelo meteorológico 

(“meteorologic model”); 3) especificaciones de control (“control specifications”); y 4) datos de entrada 

(“input data”). Una simulación calcula la respuesta precipitación-escorrentía de un modelo de cuenca 

para una entrada en forma de modelo meteorológico. Las especificaciones de control delimitan el 

dominio temporal del modelo y el intervalo de cálculo. Los datos de entrada se requieren generalmente 

como parámetro o condición de contorno en los modelos de cuenca y metereológico: pluviograma, 

hidrograma, limnigrama, sección transversal, curva de calibración, etc.  

 

Las configuraciones de los componentes anteriores se muestran en el panel “Explorador de Cuenca” de 

la pantalla principal de HEC-HMS (Fig.1, arriba-izquierda). Cada uno de los elementos incluidos en los 

componentes se edita en el panel inferior “Editor de Componente” (abajo-izqda). El panel “Escritorio” 

muestra el esquema dendrítico conformado por los elementos hidrológicos, y también los resultados. El 

cuarto panel “Registro de Mensajes” contiene las notas, advertencias, y errores del proceso.   
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Figura 1. Pantalla principal de HEC-HMS. El panel de explorador de cuenca (arriba-

izquierda) muestra la configuración de los 4 componentes del modelo. 

 

1.4. Elementos hidrológicos de HEC-HMS 

La cuenca hidrográfica es representada por el modelo de cuenca, el cual está conformado por un 

conjunto de elementos hidrológicos conectados que simulan el recorrido del agua de modo ordenado. 

La tabla 1 presenta los 7 tipos de elementos hidrológicos disponibles en HEC-HMS. El usuario coloca en 

el panel escritorio un número variable de elementos hidrológicos enlazados, siguiendo el patrón de la 

red de drenaje de la cuenca natural.  

 

El modelo de cuenca más simple consiste 

como es lógico en una única subcuenca, 

conectada al sumidero en la sección de cierre. 

Cuando la cuenca se descompone en varias 

subcuencas, la propagación de hidrogramas 

sigue el esquema básico de tránsito en cauce 

y confluencia en la sección de cierre de la 

subcuenca inferior mostrado en la Figura 2. 

  

Cada elemento hidrológico puede representar 

en realidad uno o varios tipos de procesos 

hidrológicos, para cuyo modelado el programa 

ofrece diversos métodos. La tabla 2 agrupa los 

procesos aplicables en cada tipo de elemento, 

así como los diferentes métodos de resolución 

disponibles en la versión actual del programa.  

Explorador 

de cuenca 

Componentes 

del modelo 

Editor de 

Componente 

Escritorio 

Registro 

Figura 2. División de una cuenca y esquema hidrológico. 

                Modificado (Montalbán et al., 2003) 
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            Tabla 1. Diferentes tipos de elementos hidrológicos utilizables para definir un modelo de cuenca. 
 

Elemento Hidrológico Descripción 
 

Subcuenca 
 

Se utiliza para representar la cuenca hidrográfica real. Normalmente, 

la cuenca se divide en un número variable de subcuencas, las cuales 

se conectan adecuadamente siguiendo el flujo. En cada subcuenca se 

calcula la escorrentía generada por una precipitación, se genera el 

hidrograma correspondiente, y se añade el caudal base. 
 

Unión 

 

Combina los hidrogramas de los elementos localizados aguas arriba 

que confluyen en ella. El hidrograma de salida se calcula como suma 

de todos los de entrada.  

 

Derivación 

 

Representa una salida de caudal de la red de drenaje definida por el 

usuario. El caudal de salida se calcula como diferencia entre el caudal 

de entrada y el derivado. 

 

Fuente 

 

Se utiliza para introducir un hidrograma directamente en el sistema. 

Puede representar por ejemplo un trasvase, o bien un hidrograma pre-

calculado con modelos externos a HEC-HMS. 

 

Sumidero 

 

Representa la sección de cierre de la cuenca. Se caracteriza porque 

recibe el hidrograma total de respuesta, y no posee caudal de salida. 

 

Embalse 

 

Modela la detención y atenuación de una crecida en un embalse o en 

un estanque de laminación.  

 

Tramo 

 

Se emplea para propagar el hidrograma generado en un elemento 

hidrológico hasta otro elemento localizado aguas abajo. La laminación 

en cauce reduce el caudal pico y aumenta el tipo pico. Este elemento 

es muy utilizado en el sistema de agregación con modelos discretos. 

 

            Tabla 2. Procesos y métodos aplicables en cada tipo de elemento hidrológico. 
 

Elemento Hidrológico Tipo de Cálculo                       Método 

 

Subcuenca 

 

Infiltración 
Loss Rate 

 

 Pérdidas inciales y constantes 

 Número de Curva SCS 

 Greem & Ampt 

    Smith Parlange 

    Exponencial 

    Déficit constante 

  

Hidrograma 
Transform 

 

 Hidrograma unitario (HU) SCS 

 HU definido por usuario 

 HU de Clark / modificado 

 HU de Snyder 

    Hidrograma-S definido por usuario 

    Onda cinématica 

  

Caudal Base 
Baseflow 

 

 Curva de recesión (con frontera) 

    Caudal constante 

    Depósitos lineales / no lineales 

 

Tramo 

 

Tránsito 
Routing 

 

 Muskingum 

 Muskingum-Cunge 

    Onda cinemática 

    Straddle Stagger 

    Modelo Lag 

    Puls modificado 

  

Aporte/Pérdida 
Gain/Loss 

 

  Constante 

  Percolación    

             

Embalse 

 

Tránsito 
Routing 

 

 

 Método Puls 

 

Unión  

Derivación 

 

Composición 
 

 

  Constante 

  Variable 
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PRÁCTICA 1 (Básico) - Cuenca Simple: Aguacero singular  Escorrentía  Hidrograma 

 98Cuenca simple 

 Modelo de lluvia: Pluviograma 

 Infiltración-Escorrentía: Número de Curva 

 Hidrograma: H.Unitario SCS 

 Caudal Base: No 

 

La cuenca de estudio tiene un área de 3 km2, la longitud del curso principal es 1042 m, y el desnivel 

máximo vale 83 m. El número de curva estimado es 86. Se precisa calcular el hidrograma generado 

por una lluvia ocurrida el 1 Enero 2010 a las 00:00h, de duración 30 min. y precipitación 25.12 mm, 

de la cual se conoce su pluviograma en intervalos de duración 6 min. No se considera caudal base.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Configuración del programa 

 

Una vez abierto HEC-HMS, vamos a configurarlo convenientemente por primera vez: Tools>Program 

Settings. En la pestaña General active las opciones de la siguiente figura. 

 

 

 Advertir de cambios efectuados. 

 Confirmar el borrado de un componente. 

 Cerrar el proceso automáticamente si es correcto. 

 Abrir automáticamente el último proyecto al iniciar. 

 Mostrar los editores fuera del escritorio (varias ventanas). 

     Separador decimal: punto (Period); ej. 2.40. 

     Referencias en pestaña Compute: Components. 

     Directorio de proyecto: a su elección.     

 

 

 

Intervalo Tiempo (min) Precipitación (mm)

1 0 - 6 2.90

2 6 - 12 4.90

3 13 - 18 11.27

4 18 - 24 3.59

5 24 - 30 2.46

Total 30 25.12
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Configure las 4 sucesivas pestañas restantes de acuerdo a las capturas inferiores. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

CREAR NUEVO PROYECTO 

 

En la ventana principal seleccionar File>New. Indicar un 

nombre para el proyecto (Name), una descripción 

(Description), la localización de la carpeta (Location), y 

finalmente el sistema de unidades Métrico. Los tres 

primeros elementos puede fijarlos a su elección. 

 

PASO 1: DEFINIR EL MODELO DE CUENCA 

 

Ir al menú Components>Basin Model y pulsar el botón 

>New para crear un nuevo modelo. Introduzca un 

nombre (Name) a su elección y una descripción 

opcional (description). Pulse >Create y cierre el gestor 

de modelo de cuenca (Basin Model Manager). 
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En el panel de explorador de cuenca abra la carpeta Basin Models (click+/2clicks) y seleccione el 

reciente modelo (icono cuenca). Aparece entonces en el panel escritorio un lienzo blanco donde se irán 

colocando los elementos hidrológicos. Para que resulte más ilustrativo (no influye en los cálculos), 

insertaremos un mapa de la cuenca como fondo. Posicione el ratón en cualquier zona del panel 

escritorio, pulse Botón derecho>Background layers y agregue el fichero gráfico mediante Add. 

Emplearemos el fichero con extensión *.map (practica1.map), pero observe que existen otros formatos  

admitidos: shp, dbf, shx, etc.  

 

A continuación se crea el elemento hidrológico “Subcuenca” (Subbasin). Este esquema básico consiste 

en la cuenca hidrográfica simple, la cual no está subdividida en subcuencas. Para operar consideramos 

por tanto que Cuenca ≡ Subcuenca 1. En los botones de la fila debajo del menú, presione el icono de 

subcuenca y después toque en el lugar del escritorio donde desee colocarlo (Figura 1). A continuación 

incluya una sección de cierre o sumidero, pulsando el botón correspondiente (Sink) y después tocando 

el escritorio. Para conectar estos elementos, primero oprima el botón “Flecha” (a la izquierda del botón 

Subbasin). Después coloque el ratón sobre el elemento Subcuenca en el escritorio, y pulse click izqdo 

para marcarlo. Sin mover el ratón, pulse botón dcho>Connect downstream; el puntero cambia a cruz; 

desplácese hasta el icono sección de cierre y tóquelo con click izqdo. Aparecerá el conector recto. 

 

 

                  Figura 1. 

 

Para editar la subcuenca, selecciónela en el explorador de cuenca (fondo azul), e introduzca los datos 

abajo en el panel Editor de Componentes como muestra la Figura 2. En la pestaña activa Subbasin: 

área 3 km2; el método de escorrentía (Loss method) es Número de Curva (SCS Curve Number); el tipo 

de hidrograma (Transform) es Hidrograma Unitario del SCS (SCS Unit Hydrograph); y no se considera 

caudal base (Baseflow method-none). Los elementos Canopy method y Surface method no aplican en 

este método. Con un asterisco rojo se señalan los datos necesarios. El método de Número de curva se 

parametriza en la pestaña contigua Loss: introducir NC=86 y conservar el porcentaje impermeable de 

la cuenca (Impervious) en 0%. En la siguiente pestaña Transform se define el HU-SCS: tipo de gráfico 

(Graph Type) Estándar; y Tiempo de retardo (Lag Time) = 6.53 min. Recuerde que Tlag = 0.6 Tc.   

 

                 Fórmula California-Kirpich (1942).  
 

La pestaña Options no se utiliza.   

𝑇𝑐 = 0.0195 (
𝐿3

𝐻
)

0.385

=   10.88 𝑚𝑖𝑛 
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               Figura 2. 

 

PASO 2: DEFINIR LAS ESPECIFICACIONES DE CONTROL 

 

Las Especificaciones de Control (Control Specifications) delimitan la duración del escenario de cálculo y 

la precisión de los resultados. Desde el menú principal seleccione Components>Control Specification 

Manager y cree unas nuevas especificaciones con >New. Ahora seleccione en el panel de explorador de 

cuenca el elemento Control Specification y edítelo en el panel inferior (Figura 3): días y horas de inicio y 

de final de la simulación, e Intervalo de cálculo (Time interval). Desde 01Jan2010 - 00:00 hasta 

01Jan2010 - 01:30 con t=6min. Nota: respetar el formato de fecha (ddMMYYYY) y hora (HH:mm).  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                                

                                  Figura 3. 
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PASO 3: INTRODUCIR LA LLUVIA DE CÁLCULO 

 

El pluviograma se introduce desde el menú principal Components>Times series data manager. Se elige 

el tipo de dato en Data Type>Precipitation Gages, y se crea una lluvia nueva con >New. Indique un 

nombre y descripción a su preferencia. Para definir la lluvia de cálculo, selecciónelo primero en el panel 

explorador de cuenca, como un elemento en la carpeta Time-Series Data>Precipitation Gages>… hasta 

el final (01Jan2010..). Abajo, en el panel editor, se entrarán los datos tal y como muestra la Figura 4. 

En la pestaña Time-Series Gage se fijan las unidades Units>Incremental Milimeters, y la duración de los 

intervalos (Time interval) 6 minutes. En la pestaña Time Window cambie a la fecha y hora reales de la 

lluvia: 01Jan2010,00:00 - 01Jan2010,00:30. El pluviograma se introduce en la solapa Table, y su 

gráfica se muestra en la solapa Graph para comprobación. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                                       Figura 4. 

 

 Es un momento adecuado para Guardar: File>Save.  

 

 

PASO 4: DISEÑAR EL MODELO METEOROLÓGICO 

 

El modo como la precipitación de cálculo incide en la cuenca se establece desde el menú principal 

Components>Meteorologic Model Manager. Se crea un nuevo modelo de lluvia con >New. En el panel 

explorador de cuenca se selecciona el modelo recién introducido, representado mediante una nube 

lloviendo: Meteorologic Models>modelo…. (Figura 5). Abajo en el panel editor pestaña Meteorologic 

Model se especifica primeramente el método de ponderación de diferentes lluvias: este ejercicio 

consiste en un aguacero aislado conocido, por lo que se fija >Precipitation - Specified Hydrograph. 

Evapotranspiración (Evapotranspiration) y fusión nival (snowmelt) no aplican aquí. En la pestaña Basins 

hay que incluir las cuencas correspondientes a dicho modelo, por lo tanto seleccione en la columna 

Include Subbasins, marcando la celda inferior con el ratón (click izqdo.) y la opción Yes. Por último, en 

la pestaña Options puede mantener el tratamiento de los datos en blanco (Replace missing-Yes), y de 

la sobreesritura (Total override-No).  
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De modo complementario, se puede seleccionar en el explorador de cuenca la pestaña inferior Results 

y activar las variables a mostrar, inclusive varias simultáneamente manteniendo la tecla CTRL. En la 

Figura 7 se muestra un gráfico de barras con el pluviograma (azul), y superpuesto el volumen infiltrado 

(rojo). La zona azul visible corresponde a la escorrentía (Excess). Debajo el hidrograma. A la derecha, 

reportes tabulares de precipitación – infiltración – escorrentía – caudal, y resumen. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figura 7. 

 

Advertencias: La configuración anterior produce el siguiente mensaje típico: “WARNING 41784 - 

Simulation time interval is greater than 0.29 * lag for subbasin, reduce simulation time interval”. Para 

solventarlo, reduzca en Especificaciones de Control el intervalo de cómputo a 2 minutos. La Figura 8 

ilustran las diferencias entre los cálculos con 6 minutos (izqda) y más precisos con 2 minutos. (dcha).   

 

 

 

 

 

 

 

 

 

 

 

 

                      

       

       Figura 8.  
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Figura 10. 

Figura 11. 

 

Ahora hay que asignar la curva de gasto al elemento sumidero. En el panel explorador seleccione en 

Basin Models el elemento sección de cierre (Sink). En editor de componente solapa Options seleccione 

en Elevation-Discharte la función de gasto introducida. Para que aparezca en la gráfica un caudal de 

referencia (Figura 12, línea horizontal), introduzca debajo en la opción Ref.Flow el valor 17 m3/s, y una 

etiqueta de referencia (Ref.Label) del tipo “desbordamiento”. 

 

Ahora se ejecuta nuevamente la simulación (con intervalo de cómputo en especificaciones de control = 

2 minutos). La nueva información que aparece en la sección de cierre es la gráfica de Nivel-Tiempo 

ligada al hidrograma (Figura 12). Se observa la profundidad máxima durante el caudal pico de 1,9 m, 

condiciones muy próximas al desbordamiento.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                   Figura 12. 

 

 

 Por último, puede dedicar un tiempo a revisar las opciones de formato del gráfico de la Figura 

12, presionando el botón Edit Graph Properties (ver flecha Fig.12, mano agarrando ficha) 
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PRÁCTICA 4 – C. Compuesta  NC HUT  Conducción Cauce  Agregación subcuencas 

 Cuenca compuesta: 2 subcuencas 

 Modelo de lluvia: distinta en cada subcuenca 

 Infiltración-Escorrentía: NC  

 Hidrograma: HUT-Témez (MOPU, 1987 – España). 

 Caudal Base: no 

 Propagación en Cauce: Método Muskingum-Cunge (8 puntos). 
 

Este ejercicio explica la ejecución del tránsito de un hidrograma en un tramo fluvial mediante el método 

de Muskingum-Cunge. Aplicando los conocimientos previos sobre unión y tránsito de hidrogramas, 

aprenderemos a diseñar un modelo de fraccionamiento de cuenca en subcuencas.  

 

La Figura 1 presenta una cuenca de estudio dividida en dos subcuencas: Alta y Baja. La zona Alta tiene 

una superficie de 3 km2, tiempo de concentración 30 minutos, y NC=86. Sobre ella incide un 

pluviograma de duración 30 minutos y volumen 25.12 mm, compuesto de 5 intervalos de duración 6 

minutos cada uno con las siguientes precipitaciones (mm): 2.90 – 4.90 – 11.27 – 3.59 – 2.45. La 

subcuenca Baja tiene una extensión de 4 km2, tiempo de concentración 48 min y NC=92. Sobre ella 

incide el siguiente pluviograma con intervalos de 6 minutos (mm): 2.90 – 6.20 – 10.30 – 3.20 – 2.10. 

Cabe destacar que las dos lluvias comienzan y finalizan al mismo tiempo (no hay desfase temporal) 

 

La longitud fluvial entre las secciones de cierre de las subcuencas alta (A) y baja (B) es LAB=2500 m. La 

pendiente longitudinal media de dicho tramo de propagación es 0.005 (m/m). La geometría de la 

(única) sección transversal representativa (Figura 2) tiene una anchura de 31 m y profundidad máxima 

2 m; se define mediante 8 puntos topográficos (distancia/elevación): 0/2, 5/1, 15/1, 16/0, 21/0, 

22/1, 27/1, y 31/2. Los coeficientes de rugosidad de Manning de dicha sección son: margen izquierda 

= 0.0985; cauce = 0.062; margen derecha = 0.075. 
 

 

 

 

 

 

 

 

 

 

 

 

 

El sistema de división de la cuenca incluye:  
 

1) hidrograma de subcuenca Alta (A). 

2) Tránsito de ese hidrograma por la longitud fluvial AB.  

3) Unión de dos hidrogramas en el punto B: Conducido AB + hidrograma de subcuenca Baja. 

Subcuenca

Alta

Subcuenca

Baja

S = 3 km2

Tc = 0,5 h

NC = 86

S = 4 km2

Tc = 0,8 h

NC = 92

B

A

L A-B
= 2500 m

Subcuenca

Alta

Subcuenca

Baja

S = 3 km2

Tc = 0,5 h

NC = 86

S = 4 km2

Tc = 0,8 h

NC = 92

B

A

L A-B
= 2500 m

Figura 1. Figura 2. 
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Extensión HEC-GeoHMS 

Introducción 

HEC-GeoHMS es una extensión de la aplicación informática ArcGis que contiene un conjunto de 

herramientas hidrológicas geoespaciales. Dicha extensión permite visualizar información espacial, 

documentar características de la cuenca, realizar análisis espaciales, delinear cuencas y ríos, construir 

las entradas para modelos hidrológicos. Una capacidad muy interesante de GeoHMS es la de crear 

modelos de cuenca (Basin Model) para ser importados desde HEC-HMS. 

En nuestro caso, vamos a utilizar la extensión HEC-GeoHMS para procesar la información del terreno y 

generar una serie de entradas hidrológicas, las cuales son el modelo de cuenca inicial para HEC-HMS.  

Cabe destacar que esta extensión también permite estimar parámetros hidrológicos a partir de las 

características de la cuenca y de los cauces. Adicionalmente, puede procesar registros de precipitación 

y de caudal, aunque esta capacidad queda fuera del alcance de este curso de introducción a GeoHMS. 

Descarga ArcGis 10 

En este curso vamos a utilizar el programa ArcGis, el cual es un producto de elaborado por Esri, del cual 

facilitamos el siguiente link, en el que se presentan tres opciones de descarga gratuita (60 Day-Trial) 

http://www.esri.com/software/arcgis/arcgis10/trial.html 

Una vez que hemos descargado el ArcGis, procedemos a descargar la extensión Hec-GeoHMS, la cual 

es una aplicación gratuita elaborada por US Army Coops of Engineers y se descarga a partir del 

siguiente link, seleccionando la extensión correspondiente a HEC-GeoHMS 10 for ArcGis 10.0. 

http://www.hec.usace.army.mil/software/hec-geohms/download.html 

Instalación del HEC-GeoHMS 

La extensión HEC-GeoHMS incorpora las herramientas que se muestran a continuación (Fig.1): 

 

Figura 1.  

Una vez instalado el HEC-GeoHMS se debe de cargar en el ArcMap, seleccionamos el menú Customize 

 Toolbars… y activamos la extensión HEC-GeoHMS. 

 

Figura 2. Activación de la herramienta HEC-GeoHMS 

Del mismo modo hay que activar la extensión Spatial Analyst desde Customize  Extensions…  

http://www.esri.com/software/arcgis/arcgis10/trial.html
http://www.hec.usace.army.mil/software/hec-geohms/download.html
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Figura 6. Imagen del MDT con formato Raster 

 

PASO 2: MODELIZACIÓN DEL TERRENO 

Para la modelización del terreno se van a elaborar 9 nuevas capas, las cuales se desarrollan de forma 

secuencial, ya que para realizar un paso es indispensable la capa creada en el anterior. Estas capas 

son (se indica el proceso y el nombre de cada una de ellas): 

 

 MDT sin depresiones  FIL 

 Flow Direction  FDR 

 Flow Accumulation  FAC 

 Stream Definition  STR 

 Stream Segmentation  STRLNK 

 Catchment Delineation  CAT 

 Catchment Polygon Processing  CAT_POL 

 Drainage Line Processing  DRA_LIN 

 Watershed Aggregation  WAT_AGG 

 

MDT sin depresiones 

 

El MDT sin depresiones se elabora rellenando las depresiones, con el fin de que el agua pueda fluir de 

una celda a otra sin estancarse. Este aspecto es un requisito de la extensión. Para ello creamos el 

archivo FILL SINKS, del siguiente modo: Preprocessing > Fill Sinks (Fig.7) 

 

 
Figura  7. Comandos para determinar el MDT sin depresiones (Fill Sinks) 

 

En la ventana que aparece al continuar (Fig.8), rellenamos los dos primeros apartados obligatorios: 

 

 Input DEM: indicamos la localización del MDT (amerriver_dem) en el computador. Pinche en la 

flecha para abrir el desplegable y seleccione el fichero. Si apareciese un símbolo de error 

(círculo rojo con cruz blanca) delante de Input DEM, debería desaparecer una vez seleccionado.   
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A continuación señalamos, haciendo clic, el punto donde queramos que se localice la sección de cierre 

de la futura cuenca, según muestra la Figura 39. 

 
Figura 39. El círculo rojo indica el punto de salida de la cuenca (sección de cierre- “outlet”) 

 

Una vez seleccionado el punto de salida, aparece la ventana Project Points for EJEMPLO, en el que 

damos un nombre al punto y una descripción, en este caso podemos poner Punto 1 en ambos 

apartados y aceptamos (Fig.40). 

 

 
Figura 40. Ventana de Project Points 

 

Generate Project 

 

A continuación vamos a proceder a generar el proyecto de la zona de estudio, para ello seleccionamos 

Project Setup > Generate Project (Fig.41). 

 

 
Figura 41. Comandos para generar el proyecto 

 

Nos aparece la ventana Generate Project (Figura 42), en la que se ve un resumen de todas las capas 

generadas en el punto 4, las cuales están colocadas automáticamente. Si eventualmente la capa de 

Raw DEM no lo estuviese, tendríamos que que seleccionar nuestro MDT (amerriver_dem). 
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Figura 45. Imagen de la cuenca generada 

 

PASO 4: PROCESAMIENTO DE LA CUENCA 

 

Delimitación de las subcuencas generadas 

 

 Combinación de cuencas 

 

Este proceso se realiza cuando tenemos un número muy grande de subcuencas y queremos agruparlas 

en menos cuencas y más extensas. Para ello seguimos los siguientes pasos: 

 

 Selección de las cuencas a unir, mediante el boton de ARCMAP: Select Features (Fig.46) 

 

 
Figura 46. Icono Select Features 

 
 

Ahora pulse sobre la divisoria de la primera subcuenca seleccionada. Observe que cambia de color 

negro a celeste. Para seleccionar múltiples subuencas mantenga pulsada la tecla MAYÚSCULA (Fig.47). 

 
 

Figura 47. Selección de varias subcuencas para ser agregadas. 
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 Importación del mapa de fondo (Background layer) 

 

Para agregar la capa, nos situamos dentro de la ventana Basin Model, y hacemos clic con el botón de la 

derecha y seleccionamos Background Layers (Figura 97). 

 

 
Figura 97. Comando para introducir el Background Layer. 

 

En la ventana que aparece añadimos las capas (*.shp) creadas en ArcGis, mediante la pestaña Add… 

(Fig.98), cerramos la ventana y ya tenemos el Basin Model preparado (Fig.99). 

 

 
Figura 98. Ventana Background Maps 

 

 
Figura 99. Modelo de cuenca generado con HEC-GeoHMS. 


